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Learning Objectives:

The students will learn the following:

•	 How to create web pages using HTML.

•	 What are the various structural tags 
available to create an HTML document.

•	 What are the various page formatting 
tags available and how to use them.

10.1  Introduction to HTML

	 In the previous sections you learnt 
about Internet and web pages, whatever you 
have seen on the web is a document written 
in HTML (Hyper Text Markup Language). 
HTML is a special markup language used 
to create web pages. This language tells the 
browsers, how to display the text, images, 
animations and other contents of a hypertext 
document on the screen. The language also 
tells how to make a document interactive 
through special hyper links. 

	 HTML is not a word processing 
tool or a programming language. It is only 
a markup or page layout and hyperlink 
specification language. It describes the 
structure of a document. 

CHAPTER 10Web Page Development using 
HTML, and CSS

HTML - Structural Tags

HTML was originally 
derived from SGML 
(Standard Generalized 
Markup Language) a 

larger, complicated document 
processing language. To learn 
HTML, no need to know about 
SGML. 

10.2  Writing HTML document

	 HTML is a markup language. Writing 
in a markup language is very simple, directly 
you start the text of your web document 
and add special tags around words and 
paragraphs. The tags are coded by HTML 
commands or keywords that indicate how 
web browser should format and display the 
content.

	 HTML is made up of tags and its 
attributes. Tags are known as elements of 
HTML. Additional information such as 
colour, alignment etc., can be included with 
an HTML tag is known as attribute. Attributes 
are used to improve the appearance of an 
HTML document. You cannot create your 
own tags to create a new style or feature. 

Unit III
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	 All HTML tags should be specified within angle brackets (< >). For example, 
<HTML> is a tag. HTML is not case sensitive that means you can write an HTML tag in lower 
case or in upper case (Small letter or Capital letter). Browser treats both of them in the same 
manner. For example, you can write <HTML> as <html>; both are same. 

10.2.1  HTML Document Structure

	 An HTML document contains the text of the page itself and HTML tags, which defined 
the structure and appearance of the document. It also contains hyperlinks to other pages or to 
include multimedia elements such as audio, video, animations etc.  Entire HTML document is 
bounded within a pair of <html> and </html> tags. 

<html>
<head>
	 <title> My First Web Page </title>
</head>
<body>
	 This is my First Web Page
</body>
</html>

All HTML documents should follow this general format

	 HTML tags are generally have an opening and closing tag surrounding the text they 
affect. Opening tag turn-on a feature such as heading, bold, center etc., and closing tag turn-off 
its features. Opening and closing tags are the same name, but closing tag name preceded by a 
slash ( / ). For example, <html> is an opening tag, </html> is a closing tab.

	 Every web document has two sections viz. Heading Section and Body Section. The 
heading section is used to show the title of a webpage in title bar or tab heading in browser. 
The head section should begins with <head> tag and end with </head> tag. The tag <title> is 
used to specify the title of the webpage. 

	 The body section is used to display the main content on the browser window. The 
body section should defined within <body> and </body> tags. Whatever the text you specify 
between these tags will display on the browser window. (Refer Figure 10.1)
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Head Section

Body Section

Figure 10.1 – Internet Explorer with my first web page

10.2.2.  Structural Tags of HTML:

	 <html>, <head>, <title> and <body> these four tags are known as structural tags. These 
tags are basic essential elements to construct a web page. 

Table: 10.1

Opening Tag Closing Tag Description

<html> </html>

The <html> tag identified the document as an HTML 
document. 
All HTML documents should begins with <html> and 
end with </html>.

<head> </head>
The <head> tag contains information about the 
document, including its title, scripts used, style 
definition and document descriptions.

<title> </title>

The <title> tag contains the title of the document. The 
title specified between opening and closing tags appears 
in the title bar / page tab of the browser.
<title> tag should be placed within <head> tag.

<body> </body>
The <body> tag encloses all the tags, attributes and 
information to be displayed in the web page. 
<body> tag should be entered below the </head> tag. 

10.2.3. HTML Writing Tools
	 To get started writing HTML, there is no need of web server, web hosting or even 
internet connection. You can write, test and link web pages without a network. To create and 
testing a HTML document i.e. web page need an application (text editor) to write HTML code 
and a browser to view them. Using a simple text editor (Notepad for Windows or getit for 
Linux) is a good way to learn HTML coding. 
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10.2.3.1 Creating a Webpage
Step 1: Open a text editor
	 Windows7 : Start → All Programs 
→Accessories → Notepad
Step 2: In the appearing Note pad / Text Editor, 
type the HTML document. 
(Refer Figure 10.2)
Step 3: Save the file as HTML
•	 Click File → Save (or) Press Ctrl + S
•	 Save as dialog box appears as shown in the Figure 10.3 
•	 In “File Name” text box, type a file name with .htm or .html extension.
•	 Select “All Files” from “Save as type” list box.
•	 Click “Save” button.

Save in Location

Select "All Files"
File name with 
.htm or. html

Figure 10.3 Save As dialog box

10.2.3.2. Viewing Webpage in a Browser:
Step 1: Open a Browser (Internet Explorer / Mozilla Firefox or any)
Step 2: Click File → Open File (or) Press Ctrl + O
Step 3: From the “Open” dialog box, browse the folder in which the HTML document is saved. 
Choose the File name and click “Open” button. (Refer Figure 10.5)
Now, your web page is displayed in the browser. 
10.2.3.3 Viewing Source file
	 Source file is an HTML document, what you actually type in text editor (Notepad or 
getit). You can view your original source file in the browser. The following steps are to be 
followed to view a source file.
•	 Right click on the browser
•	 Select View Page Source (Firefox and Chrome) / View Source (Internet Explorer)  or 

Press Ctrl + U (all browser)
•	 Source file will be displayed.

Figure 10.2 – Notepad with HTML code
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•	 In Internet Explorer, View → Source is also used to open source file.
Remember that, you cannot edit the source file opened using the methods you learnt above.
10.2.3.4 Edit and Reload the source file
	 Source file can be edit only through the text editor. So, to edit the source file, open the 
source file with a text editor. When you edit a source file, no need to close browser in which 
displaying the HTML document. The following steps are to be followed to open a source file.
•	 Go to the folder in which your source files are located.
•	 According to you default browser, your source file icon is displayed. (Refer Figure 10.7)

Internet Explorer

Mozilla Firefox

Google Chorme

Figure 10.5 Source files in different browsers
•	 Right click on the source file that you want to edit
•	 From the pop-up menu, select Open With → Notepad
•	 Source file will be opened in text editor
•	 Make the changes and save the file using File → Save or Ctrl + S. 
Reload / Refresh the changes:
•	 After modify and save the source file, minimize your source file.
•	 Go to the browser.
•	 Click Refresh (Internet Explorer) / Reload Current Page (Firefox) / Reload this page 

(Chrome) icons on the address bar.
•	 Press Ctrl + R or F5 will be used to refresh / reload the modifications.
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10.3 HTML Attributes
	 Attributes are special words used inside a tag to specify additional information to a 
tag. Attributes should be placed within the opening tag.  Most of the tags support specialized 
attributes and there are also a few global elements that can be used with any tag. Global 
elements are common to all HTML elements; they can be used on all elements.
10.3.1 Attributes for Structural Tags 
1. Attributes of <html> tag
	 The <html> tag is used to specify the beginning and closing of an HTML document. 
This tag does not have any effect on appearance of document. This is only used to make 
browsers and other programs, known that this is an HTML document. 
	 <html> tag has two attributes viz. dir and lang to specify the text direction and 
language setting respectively. 

attribute Value to be set to attribute Description

dir
ltr (align left-to-right)
rtl (align right-to-left)

dir attribute specifies the direction of the text to 
be aligned within the entire document. It is global 
attribute.
•	 ltr is the default value
•	 rtl is used for Arabian languages.

lang

Predefined language code
English – en
Tamil – ta
Telugu – te

lang attribute specify the language used with in 
the document. Predefined language code will be 
used for this purpose.
Malayalam – ml; Kannada – kn; Hindi – hi; 
French – fr; German – de;  

2. Attributes of <body> tag

	 The <body> tag defines the document’s body. The contents of an HTML page reside 
within the <body> tag. <body> tag contains several attributes. 

(i) Background Colour: bgcolor = color

`	 By default all the browsers display the text on white background. However, the 
background color of the browser can be changed by using bgcolor tag. 

The tag to change background colour:

	 <body bgcolor = color_name/color_code>
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<html>
<head>
	 <title> Background Colour change </title>
</head>
	 <body bgcolor = yellow>
		  This is my browser with different colour
</body>
</html>

Illustration 10.1 – HTML code to change background colour of a browser

	 In the above HTML code, 
colour name has been used to 
change the background colour 
of the browser’s body section. 
Generally colors in HTML are 
represented as six digit hexadecimal 
values. Colour name can be used 
for only few colors. But, color code 
(hexadecimal value) will be more 
flexible to handle colors. 

	 The six digit hexadecimal 
value is the combinations of three, 
two digit number sequence represent a color. First two digits represent Red, next two digits for 
Green and last two digits for Blue (RGB) in the range of 00 – FF. For example, 000000 is black 
and FFFFFF is white. FF0000 is bright red. You can try out different combinations of these 
values to get variety of colors. 
	 You can use some basic color names or color code to handle colors in HTML elements. 
Modern browsers support nearly 140 colors. Color code should be prefixed with #. The 
following table shows some basic colors with their hexadecimal code. 

Table 10.2 – Some basic Color names with code

Color Name Hexadecimal value Color Name Hexadecimal value
Red #FF0000 Olive #808000
Blue #0000FF White #FFFFFF

Green #008000 Black #000000

Yellow #FFFF00 Maroon #800000
Lime #00FF00 Grey #808080

Purple #800080 Aqua #00FFFF
Silver #C0C0C0 Brown #A52A2A

<html>
		  <head>
			   <title> Background Colour 
change </title>
		  </head>
		  <body bgcolor = yellow>
			   This is my browser with 
different colour
		  </body>
</html>

bgcolor - Notepad
File     Edit   Format     View   Help

File     Edit    View   Favorites     Tools      Help
Background Colour change

This is my browser with different colour

D:\CS_TestBook_Final\HTML\

The Colour of the 
browser turns in yellow

Figure 10.5 Internet Explorer with 
Yellow background
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To know the complete color code visit: 
	 https://www.w3schools.com/tags/ref_colornames.asp

<html>
	 <head>
		  <title> Background Colour change </title>
	 </head>
	 <body bgcolor = #FFFF00>
		  This is my browser with different colour
	 </body>
</html>

The above illustration 10.1 can be re-written as follows to get the result

(ii) Body text Colour:  text = color
	 The default text colour of body section is “black”, it is often called as automatic color. 
text attribute within body tag is used to change the text colour. 
The tag to change body text colour:
	 <body text = color_name/color_code>

<html>
	 <head>
		  <title> Background Colour change </title>
	 </head>
	 <body bgcolor = #FFFF00>
		  This is my browser with different colour
	 </body>
</html>

Illustration 10.2 – HTML code to change background and text color of 
a browser’s body

To the above code, text will be displayed in Red color on yellow background. You can also use 
colour code instead of colour name.
(iii) Background image:  background=image
	 An image or picture can be applied as background to a webpage. When you insert an 
image as background, the text will be displayed on top of the image. Background images can 
be a texture or bitmap or even a photo. 
	 When you insert a small image, the browser takes the image and repeats it across and 
down to fill browser window. Inserting animated images (GIF images) creates more interesting. 
The tag to apply an image as background:
	 <body background = “image_name_with_extenstion”>
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<html>
<head>
	 <title> Image as background </title>
</head>
	 <body background = “flower01.gif ”>
	 This is my browser with an image as background
</body>
</html>

Illustration 10.3 – HTML code to apply an image as background

	 While including an image as 
background, the image file name is 
not required to be in double quotes. 
The code <body background = 
flower01.gif> can also produce the 
same result. 
	 If your image file name is long 
or split as two more words or along 
with path, should be specify within 
double quotes.
	 Remember that, if the image 
file and HTML source are located 
in different locations i.e. in different 
folder or drive, file path should be clearly specified along with image file name. In the above 
case, image file and HTML source file both are located within the same folder. So, path name 
is not mentioned. 
	 For example, If the image file is somewhere in a folder (say Images folder in E: drive), 
you must specify its full path within double quotes as given below.
	 <body background = “E:\Images\ flower01.gif ">
(iv)  Setting Margins:  margin = value
	 The margin refers the blank area from left or top edge of the browser window. Generally 
there is no default margin setting in any browser. If you want to leave some space as margin to 
left or top; leftmargin or topmargin attributes will be used respectively. 
The tag to specify the left and top margin:
	 <body leftmargin = value  topmargin = value>
		  The Value is referred as pixels (72 pixels to an inch)

Inserting an image as 
background

Figure 10.6 Internet Explorer with an 
image as background
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<html>
<head>
	 <title> Setting Margins </title>
</head>
	 <body leftmargin = 50  topmargin = 50>
	 This is my Web page with top and left margin
</body>
</html>

Illustration 10.4 – HTML code to set left and top margins

	 The statement <body leftmargin = 50  topmargin = 50> will intent the body text  50 
pixels away from the left as well as from top edge of the browser. 
Illustration 10.5 – Create a web page (HTML document) to the following specification. 
•	 Title: My First Web Page
•	 Text to be display: Welcome to Computer Applications
•	 Background color: Lime
•	 Body text color: Blue
•	 Margin: from left and top 1 inch

<html>
	 <head> 
		  <title> My First Web Page </title>
	 </head>
	 <body bgcolor = Lime text = blue  leftmargin = 72  topmargin = 72>
		  Welcome to Computer Applications
	 </body>
</html>

	 Remember that, when you use more than one attribute within an HTML element (Tag) 
space is used as separator.

10.4 Headings
	 Headings are used to include titles to sections of a web page. HTML has six levels of 
headings viz. <h1> to <h6>. The number with h indicates the level of heading. Header tags are 
display the body text as bolder and larger in size according to its level. 
The syntax of heading tags:
	 <h…> Heading text </h…>
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<html>
	 <head>
		  <title> Heading </title>
</head>
<body>
	 <h1> Welcome to Computer Application</h1>
	 <h2> Welcome to Computer Application</h2>
	 <h3> Welcome to Computer Application</h3>
	 <h4> Welcome to Computer Application</h4>
	 <h5> Welcome to Computer Application</h5>
	 <h6> Welcome to Computer Application</h6>
</body>
</html>

Illustration 10.6 – HTML code with Headings

<H1>

<H2>

<H3>

<H4>

<H5>

<H6>

Figure10.7 – Different levels of Headings
10.4.1 Attribute of Headings tag

	 Align is an attribute to set right, center and justify alignment to headings. Left if the 
default alignment, so that it is not supported in latest version of HTML. Justify alignment is 
not supported by older browsers.  
The tag is to specify the alignment to headings:
	 <h# align = value>
	 Where # is the level number, value may be Right, Center or Justify. Justify alignment 
only used for paragraphs. The meaning of alignment is similar what you learnt from Word 
processor.
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<html>
	 <head>
		  <title> Heading </title>
</head>
<body>
	 <h1 align=center> Welcome to Computer Application </h1>
	 <h2 align=right> Welcome to Computer Application </h2>
</body>
</html>

Illustration 10.7 – HTML code with Heading and align attributes

10.5 Line Breaks and Paragraphs
	 Browser applications are having some special rules for displaying text. They do not 
recognize returns, tabs or even more than one space between words. If you create an HTML 
document with multiple lines of text, browser will display it as a single line. (Refer Figure 10.8)

}
Multiple lines

Browser display 
multiple lines as a 
single statement. 

Because, the browser 
does not recongnize 

returns

Figure 10.8 Multiline statement displayed as Single line
	 The <br> tag is used for line break. The <br> is an empty tag, does not have close tag 
and attribute. It should be placed at the end of a line.  (Refer Figure 10.9)
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}

}
}

Multiple lines 
with <br> tag

Multiple lines 
without <br> tag

Figure 10.9 Usage of <br> tag

	 In HTML, paragraphs are created using the <p> tag. The content what you type 
between <p> and </p> is identified as a paragraph and display as a paragraph by the browser. 
Because, the browser does not recognize returns (Pressing “Enter” Key). Remember that in 
word processors, pressing “Enter” key is identifying a paragraph. 

<html>
	 <head>
		  <title> Paragraph </title>
</head>
<body>
	 <h1 align=center> Business </h1>
<p> Business may be defined as any activity in which a man is 
very much interested and these activities bring him profit, money, 
prestige and power. </p> <p> In economic sense, the term business 
means works, efforts and acts of people, which are connected with 
the production of wealth and activities, which are directed with 
the object of making profit.</p> <p> Production and distribution 
of goods to consumers for a profit constitute business. </p>
</body>
</html>

Illustration 10.8 HTML code to create a paragraph
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	 In the above illustration, the contents specified between <p> and </p> considered as 
paragraph. Each paragraph displayed separately (Refer Figure 10.10).

Figure 10.10 Browser with Paragraphs
Changing Paragraph alignment

	 You know already that the types of paragraph alignments in Word processor. In HTML 
documents more are four paragraph alignments viz. Left, Right, Center and Justify. The text 
that you type between <p> and </p> is by default aligned to left. To change the alignment of a 
paragraph align attribute can be used with <p> tag.

The tag to specify the alignment to paragraphs:

		  <p align = alignment>

	 Where alignment can either be Right, Center or Justify. Remember that, left is the 
default alignment.

	 Remember that, the keyboard shortcut to change paragraph alignment in word 
processor is not working in HTML.

10.6  Comments

	 Comments are used to describe the page or provide some kind of indication of the 
status of the page. The tag <!> is used to create comments. In HTML, the text what you type 
within this tag is considered as comments and it is ignored by the browser. Comments never 
show up onscreen. Comments can be placed anywhere in HTML document. 
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The general form of comments:

		  <! comments >

10.7  Container and Empty Elements
	 The HTML elements (Tags) can be classified as two types – (1) Container elements (2) 
Empty elements.

Container Elements: 

•	 The tags which are required opening and closing is known as container elements or tags. 
For example:  <html>, <body>, <title>, <p> etc.,

Empty Elements:

•	 The tags which are required only opening tag is known as empty elements or tags. For 
example: <br>

Points to Remember:

•	 HTML (Hyper Text Markup Language)  is a special markup language used to create 
web pages

•	 HTML is not a word processing tool or a programming language.
•	 HTML is made up of tags and its attributes. 
•	 Tags are known as elements of HTML. 
•	 Attribute is special word used inside tag to specify additional information to the tag 

such as color, alignment etc.
•	 Every web document has two sections viz. Heading Section and Body Section.
•	 <html>, <head>, <title> and <body> these four tags are known as structural tags
•	 List of HTML tags from Section-I

Table 10.3

Opening 
Tag

Closing 
Tag

Type Function Attributes Contains
Used 

inside

<html> </html> Container

Delimits a 
complete 
HTML 

document

Dir, Lang <head>, <body>

<head> </head> Container
Defines the 

function 
header

-- <title> <html>

<title> </title> Container
Defines the 
document 

title
-- Text <head>
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<body> </body> Container
Defines the 
document 

body

Background, 
Bgcolor, Text, 
Leftmargin, 
Topmargin

All tags that 
controls the 
appearance of 
body of the web 
p a g e

<html>

< h 1 > , 
< h 2 > … . 
< h 6 >

< / h 1 > , 
< / h 2 > , 
…… </
h 6 >

Container
Defines one 

of six levels of 
headings

Align Text <body>

<p> </p> Container
Defines a 

paragraph of 
text

Align Text <body>

<br> -- Empty
Insert a line 

break
--- --- Text

Workshop - 1

	 Type the following code in a text editor, save it as an html file and open in a browser. 
Observe and study their functions by viewing them in your browser. Then, make the required 
changes and look what happens. 

<html>
<body>
<h1> Thai Pongal </h1>
<p> Pongal is a harvest festival dedicated to the Sun. It is a four-
day festival which according to the Tamil calendar is usually 
celebrated from 14 January to 17 January. </p>
<p> Thai Pongal is one of the most important festivals celebrated 
by Tamil people in Tamil Nadu, Puducherry and the country 
of Sri Lanka, as well as Tamils worldwide, including those in 
Malaysia, Mauritius, South Africa, the United States, Singapore, 
Canada, Myanmar (Burma) and the UK. </p>
<p> Thai Pongal corresponds to Makara Sankranthi, the harvest 
festival celebrated throughout India. </p>
</body>
</html>

Carry over the following changes:

(a)	 Add a suitable title

(b)	 Center the heading

(c)	 Change the different alignment setting for each paragraph
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Evaluation

Part – I 

Choose the correct answer
1.	 HTML is acronym for
	 (a) Hyper Transfer Markup Language	 (b) Hyper Text Markup Language
	 (c) Hyper Transfer Makeup Language	 (d) Hyper Text Makeup Language

2.	 The coded HTML keywords that indicates how web browser should format and display 
the content is called…….

	 (a) Tags		  (b) Attributes		 (c) Headings		  (d) Body

3.	 Which of the following is a special word used inside tag to specify additional information 
to the tag?

	 (a) Tags		  (b) Attributes		 (c) Headings		  (d) Body

4.	 HTML tags should be specified within:
	 (a) [ ]			   (b) { }			   (c) ( )			   (d) < >

5.	 An HTML document is bounded within a pair of ….. tags
	 (a) <body> ……. </body>			   (b) <title> ……. </title>
	 (c) <html> ……. </html>			   (d) <head> …… </head>

6.	 Which of the following symbol is used to define a closing tag?
	 (a) < >			  (b) %			   (c) /			   (d) \

7.	 Which section of the browser window displays the main contents?
	 (a) Head		  (b) Body		  (c) Title		  (d) Heading

8.	 Which of the following tag is a structural tag?
	 (a) <html>		  (b) <h1>		  (c) <br>		  (d) <p>

9.	 In HTML, colours are represented as
	 (a) Binary values	 (b) Octal values	 (c) Decimal values	 (d) Hexadecimal values

10.		  Which of the following symbol is used to prefix with hexadecimal value representing 	
	 colour in HTML?

	 (a) %			   (b) #			   (c) @			   (d) &

11.	 Which of the following attribute is used to change text colour within body tag?
	 (a) bgcolor		  (c) background	 (c) text		  (d) color

12.	 Within body section, which of the following attribute is used to set top margin?
	 (a) margin		  (b) top			  (c) topmargin		  (d) leftmargin
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13.	 How many levels of heading tags available in HTML?
	 (a) 6			   (b) 4			   (c) 8			   (d) 3

14.	 The tag used to insert a line break:
	 (a) <h1>		  (b) <br>		  (c) <html>		  (d) <p>

15.	 The tag used to define a paragraph in HTML:
	 (a) <para>		  (b) <p>		  (c) <q>		  (d) <br>

Part – II
Very Short Answers

1	 Sandhiya is creating a webpage. She is entering HTML code on her computer. In between, 
she keeps pressing “Refersh” / “Reload” button on her browser. What is the purpose?

2.	 Explain with the help of an example the difference between container and empty elements 
of HTML.

3.	 What is the wrong in the following coding?

	 <html>
	 <my web page>
	 <title> Welcome to my web page
	 </head>

	 </title>

4.	 How do you define comments in HTML?

5.	 How do you include an image as your web page background?

Part-III
Short Answers

1.	 Explain the attributes available with <body> tag.

2.	 What are the attributes available in <html> tags?

3.	 How do you view the source file?

4.	 How do you save a file as HTML file?

Part-IV
Explain in Detail

1.	 Write a HTML program to display your school name and address using various 
geading level tags.

2.	 Write the basic structure of a HTML program.
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GLOSSARY

HTML – Hyper Text Markup Language used to create web pages.
Tag – A coded HTML command. It is also called as element.
Attribute – Special word, carrying special meaning used inside on HTML tag.
Heading Section – Refers title bar of a browser.
Body Section – Refers main client area of a browser.
Browser – An application to view web pages or web sites.
Web Page – An Online page contains hypertext.
Hypertext – Text which contains links to other texts.

Text Editor –
An application used to type and modifies text contents, but it is not a 
word processor.

Word Processor – An application used to create and manipulate text documents.

Notepad – A default text editor available with Windows.

Getit – A default text editor available with Linux.

Windows – Familiar GUI Operating system developed by Microsoft.

Linux – Familiar Open Source operating system.

Internet Explorer – A browser available with Windows.

Mozilla Firefox –
A default browser available with Linux. Open Source Third party 
browser can be installed in windows.

Chrome – A familiar web browser developed by Google.
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